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1.  Introduction 
 

1.1 Additional Module STEEL SP 

The Russian Standard SP 16.13330.2011 determines rules for the design, analysis and construc-
tion of steel buildings in the Russian Federation. With the add-on module STEEL SP from the 
DLUBAL SOFTWARE GMBH company all users obtain a highly efficient and universal tool to design 
steel structures according to this standard. 

All typical designs of load capacity, stability and deformation are carried out in the module 
STEEL SP. Different actions are taken into account during the load capacity design. STEEL SP 
automatically calculates the limiting width-to-thickness ratios of compressed parts and carries 
out the slenderness check of cross-section automatically. 

The sectional coordinate system in STEEL SP is different from the indices used in the Russian 
code. It corresponds to the one used in RSTAB: The indices “y” and “z” refer to the axes in the 
cross-section plane as seen in the image to the left. 

For the stability design, you can determine for every single member or set of members wheth-
er buckling is possible in the direction of y-axis and/or z-axis. Lateral supports can be added for 
a realistic representation of the structural model. The specific ratios of slendernesses and criti-
cal stresses are automatically determined by STEEL SP on the basis of the boundary conditions. 
The location where the loads are applied, which influences the lateral torsional design, can be 
defined in the detailed settings.  

The serviceability limit state has become important for the static calculation of modern civil 
engineering as more and more slender cross-sections are being used. In STEEL SP, load cases, 
load combinations and result combinations can be arranged individually to cover the various 
design situations. 

If required, you can use the add-on module to optimize cross-sections and export the modified 
cross-sections to RSTAB. Using the design cases, you can design separate structural compo-
nents in complex structures or analyze variants. 

STEEL SP is an add-on module integrated in RSTAB. For this reason, the design relevant input 
data is already preset when you have started the module. Subsequent to the design, you can 
use the graphical RSTAB user interface to evaluate the results. Finally, the design process can 
be documented in the global printout report, from determination of internal forces to design. 

We hope you will enjoy working with STEEL SP. 

Your DLUBAL Team 
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1.2 STEEL SP Team 
The following people participated in the development of the STEEL SP module: 

Program Coordinators 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) Younes El Frem 

Ing. Ph.D. Peter Chromiak 

Programmers 
Ing. Zdeněk Kosáček 
Ing. Ph.D. Peter Chromiak 
Ing. Martin Budáč  
Mgr. Petr Oulehle 

Dipl.-Ing. Georg Dlubal 
Dr.-Ing. Jaroslav Lain 
Ing. Zbyněk Zámečník  
Ing. Jakub Melka  

Library of Cross-Sections and Materials 
Ing. Ph.D. Jan Rybín 
Stanislav Krytinář 

Jan Brnušák 
 

Design of Program, Dialog Boxes and Icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Testing and Technical Support 
Ing. Martin Hlavačka 
Ing. Ph.D. Peter Chromiak 
Dipl.-Ing. (BA) Markus Baumgärtel 
M.Sc. Sonja von Bloh 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Walter Fröhlich 

Dipl.-Ing. (FH) Wieland Götzler 
Dipl.-Ing. (FH) Ulrich Lex 
Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 

Manuals, Documentation and Translations 
Ing. Ph.D. Peter Chromiak 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Ladislav Kábrt 

Dipl.-Ing. Frank Faulstich 
MA Translation Anton Mitleider 
Ing. Dmitry Bystrov 

1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RSTAB. The present manual focuses on typical fea-
tures of the add-on module STEEL SP. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. The text of the manual shows the described buttons in square brackets, for 
example [View mode]. At the same time, they are pictured on the left. Expressions appearing 
in dialog boxes, windows, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you don’t find what you are looking 
for, please check our website www.dlubal.com where you can go through our comprehensive 
FAQ pages by selecting particular criteria. 

http://www.dlubal.com/
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1.4 Starting STEEL SP 
RSTAB provides the following options to start the add-on module STEEL SP. 

Menu 
To start the program in the RSTAB menu bar, click 

Add-on Modules → Design - Steel → STEEL SP. 

 

Figure 1.1: Main Menu: Additional Modules → Design - Steel → STEEL SP 

Navigator 
You can also start the add-on module in the Data navigator by clicking 

Add-on Modules → STEEL SP. 

 

Figure 1.2: Data Navigator: Add-on Modules → STEEL SP 
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Panel 
If results from STEEL SP are already available in the RSTAB model, you can also open the design 
module in the panel: 

Set the relevant STEEL SP design case in the load case list of the RSTAB toolbar. Then click the 
button [Show Results] to display the design criterion on the members graphically. 

When the results display is activated, the panel is available, too. Now you can click the button 
[STEEL SP] in the panel to open the module. 

 
Figure 1.3: Panel button [STEEL SP] 
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2. Input Data 
When you have started the add-on module, a new window opens. In this window, a Navigator 
is displayed on the left, managing the windows that can be currently selected. The drop-down 
list above the navigator contains the design cases (see chapter 7.1, page 46). 

The design relevant data is defined in several input windows. When you open STEEL SP for the 
first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, result combinations, and super combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a window, click the corresponding entry in the navigator. To set the previous or next 
input window, use the buttons shown on the left. You can also use the function keys to select 
the next [F2] or previous [F3] window. 

Click [OK] to save the results. Thus you exit STEEL SP and return to the main program. If you 
click [Cancel], you exit the module but without saving the data. 

2.1 General Data 
In window 1.1 General Data, you select the members, sets of members, and actions that you 
want to design. The tabs are managing the load cases, load combinations, result combinations 
and super combinations for the different designs. 

 
Figure 2.1: Window 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box: Then you can access the input fields to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be selected by double-clicking and overwritten by entering the data manually. Alter-
natively, you can select the objects graphically in the RSTAB work window after clicking []. 

When you design a set of members, the program determines the extreme values of the de-
signs of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the result 
windows 2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 
Parts List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RSTAB 
appears where you can specify the parameters for a set of members. 

2.1.1 Ultimate Limit State 

 
Figure 2.3: Window 1.1 General Data, Ultimate Limit State tab 

Existing Load Cases and Combinations 
This column lists all load cases, load combinations, result combinations, and super combina-
tions created in RSTAB.  

Click [] to transfer selected entries to the list Selected for Design on the right side. You can also 
double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common for 
Windows applications. 

Load cases marked by an asterisk (*), like load cases 8 to 10 in Figure 2.3, cannot be designed: 
This happens when the load cases are defined without any load data or the load cases contain 
only imperfections. When you transfer the load cases, a corresponding warning appears. 
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At the end of the list, several filter options are available. They will help you assign the entries 
sorted by load case, load combination, or action category. The buttons have the following 
functions: 

 
Select all cases in the list. 

 
Invert selection of load cases. 

Table 2.1: Buttons in tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases, load and result combinations selected for design. 
To remove selected items from the list, click [] or double-click the entries. To transfer the en-
tire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all contained load cases and load combinations. However, the analysis of a result combina-
tion has also disadvantages: First, the influence of the contained loads is difficult to discern. 

Second, for the determination of the elastic critical moment for lateral-torsional buckling, the 
envelope of the moment distributions is analyzed, from which the most unfavorable distribu-
tion (max or min) is taken. However, this distribution only rarely reflects the moment distribu-
tion in the individual load combinations. Thus, in the case of a RC design, more unfavorable 
values for the elastic critical moment are to be expected, leading to higher ratios. 

Result combinations should be selected for design only for dynamic combinations. For "usual" 
combinations, load combinations are recommended. 

 

Result  
combination 
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2.1.2 Serviceability Limit State 

 
Figure 2.4: Window 1.1 General Data, Serviceability Limit State tab 

Existing Load Cases and Combinations 
This section lists all load cases, load combinations, result combinations, and super combina-
tions created in RSTAB. 

Selected for Design 
Load cases, load combinations, and result combinations can be added or removed, as de-
scribed in chapter 2.1.1. 

The limit values of the deformations are controlled by the settings in the Details dialog box 
(see Figure 3.1, page 25) which you can call up by clicking the [Details] button. 

In the window 1.7 Serviceability Data, the reference lengths decisive for the deformation check 
are managed (see chapter 2.7, page 23). 
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2.2 Materials 
The window consists of two parts. In the upper part, all materials created in RSTAB are listed. In 
the Material Properties section, the properties of the current material, that is, the table row cur-
rently selected in the upper section, are displayed. 

 
Figure 2.5: Window 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in chap-
ter 4.2 of the RSTAB manual (Main Properties). The material properties required for design are 
stored in the global material library. The values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select in the mod-
ule's menu Settings → Units and Decimal Places (see chapter 7.3, page 50). 

Material Description 
The materials defined in RSTAB are already preset, but it is always possible to modify them: To 
select the field, click the material in column A. Then click [] or press function key [F7] to open 
the material list. 

 
Figure 2.6: List of materials 
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According to the design concept of SP 16.13330.2011 [1], you can select only materials of the 
“Steel” category. 

When you have imported a material, the design relevant Material Properties are updated. 

If you change the material description manually and the entry is stored in the material library, 
STEEL SP will import the material properties, too. 

Principally, it is not possible to edit the material properties in the add-on module STEEL SP. 

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog box, 
click 

Edit → Material Library 

or use the button shown on the left. 

 
Figure 2.7: Dialog box Material Library 

In the Filter section, Steel is preset as material category. Select the steel grade that you want to 
use for the design in the list Material to Select. The corresponding properties can be checked in 
the dialog section below. 

Click [OK] or [↵] to transfer the selected material to window 1.2 of the module STEEL SP. 

Chapter 4.2 in the RSTAB manual describes in detail how materials can be filtered, added, or 
rearranged. 

You can also select material categories like Cast Iron or Stainless Steel. Please check, however, 
whether these materials are covered by the design concept of the Code [1].  
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2.3 Cross-Sections 
This window manages the cross-sections used for design. In addition, the window allows you 
to specify optimization parameters. 

Coordinate System 

The sectional coordinate system in STEEL SP is different from the indices used in the Russian 
standard. It corresponds to the one used in RSTAB (see image in Figure 2.8): The y-axis is the 
major principal axis of the cross-section, the z-axis the minor axis. This coordinate system is 
used for both the input data and the results. 

 
Figure 2.8: Window 1.3 Cross-Sections 

Cross-Section Description 
The cross-sections defined in RSTAB are preset together with the assigned material numbers. 

To modify a cross-section, click the entry in column B selecting this field. Click [Cross-section 
Library] or [...] in the field or press function key [F7] to open the cross-section table of the cur-
rent input field (see the following figure). 

In this dialog box, you can select a different cross-section or a different cross-section table. To 
select a different cross-section category, click [Back to cross-section library] to access the gen-
eral cross-section library. 

Chapter 4.3 of the RSTAB manual describes how cross-sections can be selected from the library. 
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Figure 2.9: IS cross-sections in the cross-section library 

The new cross-section description can be entered in the input field directly. If the data base 
contains an entry, STEEL SP imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections set in STEEL SP are different from the ones used in RSTAB, both cross-sections 
are displayed in the graphic in the right part of the window. The designs will be performed 
with the internal forces from RSTAB for the cross-section selected in STEEL SP. 

Cross-Section Type for Classification 
The cross-section type used for the classification is displayed, e.g. I-shape rolled, welded, box, 
round bar, etc. Cross-sections that are not covered by the standard are classified as General. 

Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
zation. By means of the displayed design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overloaded and thus undersized. 

Optimize 
You can optimize every cross-section from the library: For the RSTAB internal forces, the pro-
gram searches the cross-section in the same table that comes as close as possible to a user-
defined maximum ratio. The maximum ratio can be defined in the Details dialog box (see  
Figure 3.1, page 25). 

If you want to optimize a cross-section, open the drop-down list in column D or E and select 
the desired entry: From Current Row or, if available, From favorites 'Description'. Recommenda-
tions for the cross-section optimization can be found in chapter 7.2 on page 48. 
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Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

A warning might appear before the calculation: Incorrect type of cross-section! This means that 
there is a cross-section that is not registered in the data base. This may be a user-defined cross-
section, or a SHAPE-THIN cross-section that has not been calculated yet. To select an appropri-
ate cross-section for design, click [Library] (see description after Figure 2.8). 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, the 
module displays both cross-section numbers in two rows, in accordance with the definition in 
RSTAB. 

STEEL SP also designs tapered members, provided that the cross-section at the member's start 
has the same number of stress points as the cross-section at the member end. For example, 
the normal stresses are determined from the moments of inertia and the centroidal distances 
of the stress points. If the start and the end cross-section of a tapered member have not the 
same number of stress points, the intermediate values cannot be interpolated. The calculation 
is possible neither in RSTAB nor in STEEL SP. 

The cross-section's stress points including numbering can also be checked graphically: Select 
the cross-section in window 1.3 and click [Info]. The dialog box shown in Figure 2.10 appears. 

Info About Cross-Section 
In the dialog box Info About Cross-Section, you can view the cross-section properties, stress 
points and c/t-parts. 

 
Figure 2.10: Dialog box Info about Cross-Section 

In the right part of the dialog box, the currently selected cross-section is displayed. 

The buttons below the graphic have the following functions: 
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Table 2.2: Buttons of cross-section graphic 

Click [Details] to call up detailed information on stress points (distance to center of gravity, 
statical moments of area, normalized warping constants etc.) and c/t-parts. 

 
Figure 2.11: Dialog box Stress Points of IP-B 55 B1 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the c/t-parts 

 
Displays or hides the numbering of stress points or c/t-parts 

 
Displays or hides the details of the stress points or c/t-parts (see Figure 2.11) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 
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2.4 Intermediate Lateral Restraints 
In window 1.4, you can define intermediate lateral restraints for members. STEEL SP always as-
sumes this kind of support to be perpendicular to the cross-section's minor axis z (see Figure 
2.8). Thus, it is possible to influence the members' effective lengths which are important for the 
design of column buckling and lateral torsional buckling. 

For the calculation, all intermediate lateral restraints are considered as torsional supports. 

 
Figure 2.12: Window 1.4 Intermediate Lateral Restraints 

In the upper part of the window, you can assign up to nine lateral supports for each member. 
The Settings section shows the input as column overview for the member selected above. 

To define the intermediate restraints of a member, select the Lateral Restraint check box in  
column A. To graphically select the member and to activate its row, click []. By selecting the 
check box, the other columns become available for you to enter the parameters. 

In column C, you specify the number of the intermediate restraints. Depending on the specifi-
cation, one or more of the following Intermediate Lateral Restraints columns for the definition 
of the x-locations are available. 

If the check box Relatively (0 … 1) is selected, the support points can be defined by relative-
input. The positions of the intermediate supports are determined from the member length 
and the relative distances from the member start. When the check box Relatively (0 ... 1) is 
cleared, you can define the distances manually in the upper table. 

In case of cantilevers, avoid intermediate restraints because such supports divide the member 
into segments. For cantilevered beams, this would results in segments with torsional restraints 
on one end each that are statically underdetermined. 
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2.5 Effective Lengths - Members 
Window 1.5 consists of two parts. In table in the upper part provides summarized information 
on the effective length coefficients µy and µz, the effective lengths  µyl and µzl, the effective 
lengths lef for lateral-torsional buckling and the beam type of the members to be designed. The 
effective lengths defined in RSTAB are preset. In the Settings section, further information is 
shown about the member whose row is selected in the upper section. 

Click the button [] to select a member graphically and to show its row. 

Changes can be made in the table as well as in the Settings tree. 

 
Figure 2.13: Window 1.5 Effective Lengths - Members 

The effective lengths for the column buckling about the minor axis z and the effective lengths 
for lateral-torsional buckling are aligned automatically with the entries of window 1.4 Interme-
diate Lateral Restraints. If intermediate restraints divide the member into member segments of 
different lengths, the program displays no values in the table columns G and J of window 1.5. 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically in the work window after clicking [...]. This button is enabled when you click in the 
input field. 

The Settings tree manages the following parameters: 

• Cross-section 

• Length (actual length of the member) 

• Buckling Possible (cf column A)  

• Buckling About Major Axis y Possible (buckling lengths, cf columns B - D) 

• Buckling About Minor Axis z Possible (buckling lengths, cf columns E - G) 

• Lateral-Torsional Buckling Possible (cf column H) 

• Beam Type (cf column I) 

• Lateral-Torsional Buckling Length (cf column J) 
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In this table, you can specify for the currently selected member whether to carry out a buckling 
or a lateral-torsional buckling analysis. In addition to this, you can adjust the Effective Length 
Factor for the respective lengths. When a coefficient is modified, the equivalent member 
length is adjusted automatically, and vice versa. 

You can also define the buckling length of a member in a dialog box. To open it, click the but-
ton shown on the left. It is located on the right below the upper table of the window.  

 
Figure 2.14: Dialog box Select Effective Length Coefficient 

In this dialog box, the values of the coefficient µ can be defined that are to be assigned to the 
selected member(s). The µ coefficients are described in detail in [1], clause 10.3 – Effective 
lengths of columns (page 240). Generally, it is possible to select predefined coefficients or to 
enter User-defined values. 

If a RSBUCK case calculated according to the eigenvalue analysis is already available, you can 
also select a Buckling mode to determine the factor.  

Buckling Possible 
A stability analysis for buckling and lateral buckling requires the ability of members to absorb 
compressive forces. Therefore, members for which such absorption is not possible because of 
the member type (for example tension members, elastic foundations, rigid connections) are 
excluded from design in the first place. The corresponding rows appear dimmed and a note is 
indicated in the Comment column. 

The Buckling Possible check boxes in table row A enable and in the Settings tree enable you to 
classify specific members as compression members or, alternatively, to exclude them from the 
design according to [1].  
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Axis system 

 

Buckling About Axis y or Axis z 
With the check boxes in the Possible table columns, you decide whether a member is suscepti-
ble to buckling about the y-axis and/or z-axis. These axes represent the local member axes, 
with axis y being the "major" and axis z the "minor" member axis. The effective length coeffi-
cients µy and µz for buckling about the major or the minor axes can be selected freely. 

You can check the position of the member axes in the cross-section graphic in window 1.3 
Cross-Sections (see Figure 2.8, page 14). To access the RSTAB work window, click [View mode]. 
In the work window, you can display the local member axes by using the member's context 
menu or the Display navigator. 

 
Figure 2.15: Displaying the member axes in the Display navigator of RSTAB 

If buckling is possible about one or even both member axes, you can enter the buckling length 
coefficients as well as the buckling lengths in the columns C and D respectively F and G. The 
same is possible in the Settings tree. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a µl input field. 

When you define the effective length coefficient µ, the program determines the effective 
length µl by multiplying the member length l by this buckling length coefficient. 

Lateral-Torsional Buckling 
Table column H controls whether a lateral torsional buckling design is to be carried out.  

Column I provides two options to allocate the Beam Type according to [1] Annex G, Tables G.1 
and G.2. 

The lateral-torsional buckling lengths lef depend on the settings of window 1.4 Intermediate 
Lateral Restraints. There is also a possibility to insert a user-defined value into the column J. 

Comment 
In the last table column, you can enter your own comments for each member to describe, for 
example, the effective member lengths. 

Below the Settings table, you find the Set input for members No. check box. If selected, the set-
tings entered afterwards will be applied to the selected or to All members. Members can be  
selected by typing the member number or by selecting them graphically using the [] button. 
This option is useful when you want to assign the same boundary conditions to several mem-
bers. Please note that already defined settings cannot be changed subsequently with this 
function. 
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2.6 Effective Lengths - Sets of Members 
The input window 1.6 controls the effective lengths for sets of members. It is only available if 
one or more sets of members have been selected in window 1.1 General Data. 

 
Figure 2.16: Window 1.6 Effective Lengths - Set of Members 

The concept of this window is similar to the one in the previous 1.5 Effective Lengths - Members 
window. In this window, you can enter the effective lengths of the set of members for buckling 
and lateral-torsional buckling as described in chapter 2.5. 
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2.7 Serviceability Data 
This input window controls several settings for the serviceability limit state design. It is only 
available if you have set the according entries in the Serviceability Limit State tab of window 1.1 
General Data (see Figure 2.4, page 11). 

 
Figure 2.17: Window 1.7 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RSTAB work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

Table column E defines the governing Direction for the deformation analysis. You can select 
the directions of the local member axes y and z (or u and v for unsymmetrical cross-sections). 

A precamber wc can be taken into account by using entries specified in column F. 

The Beam Type is of vital importance for the correct application of limit deformations. In table 
column G, you can select the girder to be a beam or a cantilever and decide which end should 
have no support. 

The settings of the Details dialog box determine whether the deformations are related to the 
undeformed initial model or to the shifted ends of members or sets of members (see Figure 3.1, 
page 25). 
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2.8 Parameters - Members 
The last input window controls additional design parameters for members. 

 
Figure 2.18: Window 1.8 Parameters - Members 

Service Factor 
In column A, there is the possibility to set a value of service factor according to [1] Table 1.  
The value is set as 0.9 by default. However, it is important to check the structural member and 
to correct this value if appropriate. 

Cross-Sectional Area 
Column B provides an option to reduce the cross-sectional area of the selected member. The 
values of reduced net cross-sectional areas are related to the start and end of the members. 
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3. Calculation 
 

3.1 Details 
Before you start the [Calculation], it is recommended to check the design details. You can open 
the corresponding dialog box in all windows of the add-on module by clicking [Details]. 

 
Figure 3.1: Dialog box Details 

Check of Maximum Effective Slenderness Ratio 
In the two input fields, you can specify the limit values K · L / r of the slenderness ratios. It is 
possible to enter specifications separately for members with pure tension forces and members 
with bending and compression. 

The real member slendernesses are compared to the limit values in window 3.3. This window  
is available after the calculation (see chapter 4.8, page 35) if the corresponding check box is 
selected in the dialog section Display Result Tables. 

This check does not apply to the member types "Tension" and "Cable" because they are ex-
cluded from this check. 

Serviceability (Deflections) 
In this section, it is possible to change set the allowable deflection for the serviceability limit 
state design if the default value L/300 is not appropriate. 

The two option fields below control whether the Deformation is to be related to the shifted 
ends of members or sets of members (connection line between start and end nodes of the de-
formed system) or to the undeformed initial system. As a rule, the deformations have to be 
checked relative to the displacements in the entire structural system. 
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Stability Analysis 
When ticking the check box in this dialog section, you decide if you want to perform a Stability 
Analysis generally. If you clear the check box, the input windows 1.4 to 1.7 won't be displayed. 

Load application of positive transverse loads 
Usually, loads act on members (transverse loads). It is important to define where these forces 
are acting on the cross-section: Depending on the Load Application point, transverse loads can 
be stabilizing or destabilizing, and in this way they can decisively influence the lateral torsional 
buckling design. 

Cross-Section Optimization 
The optimization is targeted on the maximum design ratio of 100 %. If necessary, you can 
specify a different limit value in this input field. 

Partial Safety Factors 
In this section, you can change partial safety factor γm according to [1] Table 3. The most com-
mon value is set as default for this factor.  

Limit Values for Special Cases 
It is possible to neglect small stresses due to Bending, Tension, Compression or Torsion and, 
thus, allow a simplified design which eliminates negligible internal forces. In this dialog sec-
tion, the limits of the different types of stresses can be defined. Those are the ratios between 
the existing stresses and the corresponding resistances of each cross-section. 

These limit settings are not part of the code [1]. Changing the limits is in the responsibility of 
the program user. 

Options 
All cross-sections are automatically classified as Class 1 so that there is an elastic design. Alter-
natively, you can activate the Plastic Design for all cross-sections. 

Display Result Tables 
In this dialog section, you can select the results windows including parts list that you want to 
be displayed. The windows are described in chapter 4 Results. 

The 3.3 Member Slendernesses window is inactive by default. 
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3.2 Start Calculation  
To start the calculation, click the [Calculation] button that is available in all input windows of 
the STEEL SP add-on module. 

STEEL SP searches for the results of the load cases, load and result combinations to be designed. 
If these cannot be found, the program starts the RSTAB calculation to determine the design rel-
evant internal forces. 

You can also start the calculation in the RSTAB user interface: In the dialog box To Calculate 
(menu Calculate → To Calculate), design cases of the add-on modules like load cases and load 
combinations are listed. 

 
Figure 3.2: To Calculate Dialog box 

If the STEEL SP design cases are missing in the Not Calculated list, select All or Add-on Modules 
in the drop-down list at the end of the list. 

To transfer the selected STEEL SP cases to the list on the right, use the button []. Click [OK] to 
start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the STEEL SP design case in 
the toolbar list, and then click [Show Results]. 

 
Figure 3.3: Direct calculation of a STEEL SP design case in RSTAB 

Subsequently, you can observe the design process in a separate dialog box. 
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4. Results 
Window 2.1 Design by Load Case is displayed immediately after the calculation. 

 
Figure 4.1: Results window with designs and intermediate values 

The designs are shown in the results windows 2.1 to 2.5, sorted by different criteria. 

The windows 3.1 and 3.2 list the governing internal forces. Window 3.3 informs you about the 
member slendernesses. The last two results windows 4.1 and 4.2 show the parts lists sorted by 
member and set of members. 

Every window can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input window, use the buttons shown on the left. You can also use the func-
tion keys to select the next [F2] or previous [F3] window. 

Click [OK] to save the results. Thus you exit STEEL SP and return to the main program. 

Chapter 4 Results describes the different results windows one by one. Evaluating and checking 
results is described in chapter 5 Results Evaluation, page 38. 
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4.1 Design by Load Case 
The upper part of this window provides a summery, sorted by load cases, load combinations, 
and result combinations of the governing designs. Furthermore, the list is divided in Ultimate 
Limit State Design and Serviceability Limit State Design results. 

The lower part gives detailed information on the cross-section properties, analyzed internal 
forces, and design parameters for the load case selected above. 

 
Figure 4.2: Window 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load and result combinations used for 
the design. 

Member No. 
This column shows the number of the member that bears the maximum stress ratio of the 
designed loading. 

Location x 
This column shows the respective x-location where the member's maximum stress ratio oc-
curs. For the table output, the program uses the following member locations x: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Calculation Parameters) 

• Extreme values of internal forces 

Design Ratio 
Columns D and E display the design conditions according to SP 16.13330.2011 [1]. 

The lengths of the colored bars represent the respective utilizations. 
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Design according to Formula 
This column lists the code's equations by which the designs have been performed. 

DS 
The final column provides information on the respective design-relevant design situation (DS): 
ULS (Ultimate Limit State) or SLS (Serviceability Limit State). 

4.2 Design by Cross-Section 

 
Figure 4.3: Window 2.2 Design by Cross-Section 

This window lists the maximum ratios of all members and actions selected for design, sorted 
by cross-section. The results are sorted by cross-section design and serviceability limit state 
design. 

If there is a tapered member, both cross-section descriptions are displayed in the table row 
next to the section number. 
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4.3 Design by Set of Members 

 
Figure 4.4: Window 2.3 Design by Set of Members 

This results window is displayed if you have selected at least one set of members for design. 
The window lists the maximum ratios sorted by set of members. 

The Member No. column shows the number of the one member within the set of members that 
bears the maximum ratio for the individual design criteria. 

The output by set of members clearly presents the design for an entire structural group (for 
example a frame). 
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4.4 Design by Member 

 
Figure 4.5: Window 2.4 Design by Member 

This results window presents the maximum ratios for the individual designs sorted by member 
number. The columns are described in detail in chapter 4.1 on page 29. 

4.5 Design by x-Location 

 
Figure 4.6: Window 2.5 Design by x-Location 
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This results window lists the maxima for each member at the locations x resulting from the 
division points defined in RSTAB: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Calculation Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Window 3.1 Governing Internal Forces by Member 

For each member, this window displays the governing internal forces, i.e. those internal forces 
that result in the maximum utilization of each design. 

Location x 
At this x location of the member, the respective maximum design ratio occurs. 

Load Case 
This column displays the number of the load case, the load combination or result combination 
whose internal forces result in the maximum design ratios. 

Forces / Moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments producing maximum design ratios in the respective ultimate limit state and 
serviceability limit state designs. 

Design According to Formula 
The final column provides information on the types of design and the equations by which the 
designs according to [1] have been performed. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members 

This window shows the internal forces that result in the maximum ratios of the design for each 
set of members. 
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4.8 Member Slendernesses 

 
Figure 4.8: Window 3.3 Member Slendernesses 

This results window is shown only when you have selected the respective check box in the  
Details dialog box (see Figure 3.1, page 25). 

The table lists the effective slendernesses of the designed members for both directions of the 
principal axes. They were determined depending on the type of load. At the end of the list, you 
find a comparison with the limit values that have been defined in the Details dialog box (see 
Figure 3.1, page 25). 

Members of the member type "Tension" or "Cable" are not included in this table. 

This window is displayed only for information. No design of the slendernesses is carried out. 
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4.9 Parts List by Member 
Finally, STEEL SP provides a summary of all cross-sections that are included in the design case. 

 
Figure 4.9: Window 4.1 Parts List by Member 

By default, this list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Details dialog box (see Figure 3.1, page 25). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 

Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 

Surface Area 
For each part, the program indicates the surface area related to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in windows 1.3 
and 2.1 to 2.5 in the cross-section information (see Figure 2.10, page 16). 

Volume 
The volume of a part is determined from the cross-sectional area and the total length. 
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Unit Weight 
The Unit Weight of the cross-section is relative to the length of one meter. For tapered cross-
sections, the program averages both cross-section masses. 

Weight 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Weight 
The final column indicates the total mass of each part. 

Sum 
At the bottom of the list, you find a sum of the values in the columns B, D, E, F, and I. The last 
data field of the column Total Weight gives information about the total amount of steel re-
quired. 

4.10 Parts List by Set of Members 

 
Figure 4.10: Window 4.2 Parts List by Set of Members 

The last results window is displayed if you have selected at least one set of members for de-
sign. The table summarizes an entire structural group (for example a horizontal beam) in a 
parts list. 

Details on the various columns can be found in the previous chapter. If different cross-sections 
are used in the set of members, the program averages the surface area, the volume, and the 
cross-section weight. 
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5. Results Evaluation 
The design results can be evaluated in different ways. For this, the buttons in the results win-
dows are very useful which are located below the upper tables.  

 
Figure 5.1: Buttons for results evaluation 

These buttons have the following functions: 

Button Description Function 

 Ultimate Limit State Designs 
Turns on and off the results of the ultimate limit 
state design 

 
Serviceability Limit State 
Designs 

Turns on and off the results of the serviceability 
limit state design 

 Show Color Bars 
Turns on and off the colored reference scales in  
the results windows 

 Show Rows with Ratio > 1 
Displays only the rows where the ratio is greater  
than 1, and thus the design is failed 

 Result Diagrams 
Opens the window Result Diagram on Member 
 chapter 5.2, page 41 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 chapter 7.4.3, page 51 

 Member Selection 
Allows you to graphically select a member to  
display its results in the table 

 View Mode 
Jumps to the RSTAB work window to change the 
view 

Table 5.1: Buttons in results windows 2.1 through 2.5 
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5.1 Results in the RSTAB Model 
To evaluate the design results, you can also use the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB work window in the background is useful when you want to find the position of a 
particular member in the model: The member selected in the STEEL SP results window is high-
lighted in the selection color in the background graphic. Furthermore, an arrow indicates the 
member's x-location that is displayed in the selected table row. 

 
Figure 5.2: Indication of the member and the current Location x in the RSTAB model 

If you cannot improve the display by moving the STEEL SP module window, click [Jump to 
Graphic] to activate the View Mode: The program hides the module window so that you can 
modify the display in the RSTAB user interface. The view mode provides the functions of the 
View menu, for example zooming, moving, or rotating the display. The pointer remains visible. 

Click [Back] to return to the add-on module STEEL SP. 

RSTAB work window 
You can also graphically check the design ratios in the RSTAB model. Click [Graphics] to exit 
the design module. In the RSTAB work window, the design ratios are now displayed like the  
internal forces of a load case. 

In the Results navigator, you can specify which design ratios of the service or ultimate limit 
state design you want to display graphically. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RSTAB. To display the result values, use the toolbar button [Show 
Values] to the right. 

As the RSTAB tables are of no relevance for the evaluation of design results, you can hide them. 

 The design cases can be set by means of the list in the RSTAB menu bar. 
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To adjust the graphical representation of the results, you can select Results → Members in the 
Display navigator. The display of the design ratios is Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), 
the color panel becomes available. It provides the common control functions described in de-
tail in the RSTAB manual, chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

This graphics of the design results can be transferred to the printout report (see chapter 6.2, 
page 44). 

To return to the STEEL SP module, click [STEEL SP] in the panel. 
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5.2 Result Diagrams 
You can also graphically evaluate a member's result distributions in the result diagram. 

To do this, select the member (or set of members) in the STEEL SP results window by clicking in 
the table row of the member. Then open the Result Diagram on Member dialog box by clicking 
the button shown on the left. The button is located below the upper results table (see Figure 
5.1, page 38). 

The result diagrams are also available in the RSTAB graphic. To display the diagrams, click 

Results → Result Diagrams for Selected Members 

or use the button in the RSTAB toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to choose the relevant STEEL SP design case.  

The Result Diagram on Member dialog box is described in the RSTAB manual, chapter 9.5. 
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5.3 Filter for Results 
The STEEL SP results windows allow you to sort the results by various criteria. In addition, you 
can use the filter options described in chapter 9.7 of the RSTAB manual to evaluate the design 
results graphically. 

You can use the Visibility options also for STEEL SP (see RSTAB manual, chapter 9.7.1) to filter 
the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RSTAB work window which you can 
access by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is 
not shown, click 

View → Control Panel (Color Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Color spectrum). As this register is not available for the 
two-colored results display, you have to use the Display navigator and set the display options 
Colored With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the Display Hidden Result Diagram option in the Display navigator (Results → Mem-
bers), you can display all stress ratio diagrams that are not covered by the color spectrum. 
Those diagrams are represented by dotted lines.  
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. This function is described in detail in the RSTAB 
manual, chapter 9.7.3. 

 

Figure 5.7: Member filter for the stress ratios of a hall frame 

Unlike the partial view function (Visibilities), the graphic displays the entire model. The figure 
above shows the design ratios of a hall frame. The remaining members are displayed in the 
model but are shown without design ratios.
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6. Printout 
 

6.1 Printout Report 
Similar to RSTAB, the program generates a printout report for the STEEL SP results, to which 
graphics and descriptions can be added. The selection in the printout report determines what 
data from the design module will be included in the printout. 

The printout report is described in the RSTAB manual. In particular, chapter 10.1.3.4 Selecting 
Data of Add-on Modules describes how to select input and output data of add-on modules for 
the printout. 

For complex structural systems with many design cases, it is recommended to split the data 
into several printout reports, thus allowing for a clearly-arranged printout. 

6.2 STEEL SP Graphic Printout  
In RSTAB, you can add every picture that is displayed in the work window to the printout re-
port or send it directly to a printer. In this way, you can prepare the design ratios displayed on 
the RSTAB model for the printout, too. 

The printing of graphics is described in the RSTAB manual, chapter 10.2. 

Designs in the RSTAB model 
To print the currently displayed graphic of the design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print Graphic in RSTAB toolbar 

Result Diagrams 
You can also transfer the Result Diagram on Member to the report by using the [Print] button. It 
is also possible to print it directly. 

 
Figure 6.2: Button Print Graphic in the dialog box Result Diagram on Member 

The dialog box Graphic Printout opens (see figure on next page). 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RSTAB manual, chapter 10.2. The RSTAB manual also 
describes the Options and Color Spectrum tab. 

You can move a graphic anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the 
navigator of the printout report. The option Properties in the context menu opens the dialog 
box Graphic Printout, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options
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7. General Functions 
This chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design: In this way, you can combine groups 
of structural components or analyze members with particular design specifications (for exam-
ple changed materials, partial safety factors, optimization). 

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a STEEL SP design case, you can also use the load case list in the RSTAB toolbar. 

Create New Design Case 
To create a new design case, use the STEEL SP menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New STEEL SP Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the STEEL SP window 1.1 General Data where you can enter the design data. 

Rename a Design Case 
To change the description of a design case, use the STEEL SP menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename STEEL SP Case 

In this dialog box, you can define a different Description as well as a different No. for the design 
case. 
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Copy a Design Case 
To copy the input data of the current design case, use the STEEL SP menu and click 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy STEEL SP Case 

Define the No. and, if necessary, a Description for the new case. 

Delete a Design Case 
To delete design cases, use the STEEL SP menu and click 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

The design case can be selected in the list Available Cases. To delete the selected case,  
click [OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overloaded or little utilized cross-sections. 
To do this, select in column D or E of the relevant cross-sections in the 1.3 Cross-Sections win-
dow whether to determine the cross-section From the current row or the user-defined Favorites 
(see Figure 2.8, page 14). You can also start the cross-section optimization in the results win-
dows by using the context menu 

 
Figure 7.5: Context menu for cross-section optimization 

During the optimization process, the module determines the cross-section that fulfills the anal-
ysis requirements in the most optimal way, that is, comes as close as possible to the maximum 
allowable design ratio specified in the Details dialog box (see Figure 3.1, page 25). The required 
cross-section properties are determined with the internal forces from RSTAB. If another cross-
section proves to be more favorable, this cross-section is used for the design. Then, the graphic 
in window 1.3 shows two cross-sections: the original cross-section from RSTAB and the opti-
mized one (see Figure 7.7). 

For a parameterized cross-section, the following dialog box appears when you select 'Yes' from 
the drop-down list. 

 
Figure 7.6: Dialog box Welded Cross-Sections - I symmetric : Optimize 

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimization process. 
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If you want to Keep current side proportions, select the corresponding check box. In addition, 
you have to select at least two parameters for optimization. 

Cross-sections based on combined rolled cross-sections cannot be optimized. 

Please note that the internal forces are not automatically recalculated with the changed cross-
sections during the optimization: It is up to you to decide which cross-sections should be 
transferred to RSTAB for recalculation. As a result of optimized cross-sections, internal forces 
may vary significantly because of the changed stiffnesses in the structural system. Therefore, it 
is recommended to recalculate the internal forces of the modified cross-section data after the 
first optimization, and then to optimize the cross-sections once again. 

You can export the modified cross-sections to RSTAB: Go to the 1.3 Cross-Sections window, and 
then click 

Edit → Export All Cross-Sections to RSTAB. 

Alternatively, you can use the context menu in window 1.3 to export optimized cross-sections 
to RSTAB. 

 
Figure 7.7: Context menu in window 1.3 Cross-Sections 

Before the modified cross-sections are transferred to RSTAB, a security query appears as to 
whether the results of RSTAB should be deleted. 

 
Figure 7.8: Query before transfer of modified cross-sections to RSTAB 

By confirming the query and then starting the [Calculation] in the STEEL SP module, the RSTAB 
internal forces as well as the designs will be determined in one single calculation run. 
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If the modified cross-sections have not been exported to RSTAB yet, you can import the origi-
nal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in window 1.3 Cross-sections. 

If you optimize a tapered member, the program modifies the member start and end. Then it 
linearly interpolates the second moments of area for the intermediate locations. As these mo-
ments are considered with the fourth power, the designs may be inaccurate if the depths of 
the start and end cross-section differ considerably. In such a case, it is recommended to divide 
the taper into several members, thus manually modeling the taper layout. 

7.3 Units and Decimal Places 
Units and decimal places for RSTAB and the add-on modules are managed in one dialog box. 
In STEEL SP, you can use the menu to define the units. To open the corresponding dialog box, 
click 

Settings → Units and Decimal Places. 

The program opens the following dialog box that you already know from RSTAB. STEEL SP will 
be preset in the list Program / Module. 

 
Dialog box Units and Decimal Places 

You can save the settings as user profile to reuse them in other models. These functions are 
described in the RSTAB manual, chapter 11.1.3. 
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7.4 Data Transfer 
7.4.1 Export Material to RSTAB 
If you have adjusted the materials in STEEL SP for design, you can export the modified materi-
als to RSTAB in a similar manner as you export members and cross-sections: Open window 1.2 
Materials, and then click 

Edit → Export All Materials to RSTAB. 

You can also export the modified materials to RSTAB by using the context menu of window 1.2. 

 
Figure 7.9: Context menu of window 1.2 Materials 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. When you have confirmed the query and then start the 
[Calculation] in STEEL SP, the RSTAB internal forces and designs are determined in one single 
calculation run. 

If the modified materials have not been exported to RSTAB yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.9. Please note, however, 
that this option is only available in window 1.2 Materials. 

7.4.2 Export Effective Lengths to RSTAB 
If you have adjusted the materials in STEEL SP for design, you can export the modified materials 
to RSTAB in a similar manner as you export cross-sections: Open window 1.5 Effective Lengths - 
Members, and then click 

Edit → Export All Effective Lengths to RSTAB. 

or use the corresponding option on the context menu of window 1.5. 

 
Figure 7.10: Context menu of window 1.5 Effective Lengths - Members 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. 

If the modified effective lengths have not been exported to RSTAB yet, you can retransfer the 
original effective lengths to the design module, using the options shown in Figure 7.10. Please 
note, however, that this option is only available in window 1.5 Effective Lengths - Members and 
1.6 Effective Lengths - Sets of Members. 

7.4.3 Export Results 

The STEEL SP results can also be used by other programs. 

Clipboard 
To copy cells selected in the results windows to the Clipboard, press the keys [Ctrl]+[C]. To in-
sert the cells, for example in a word-processing program, press [Ctrl]+[V]. The headers of the 
table columns will not be transferred. 
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Printout report 
You can print the data of the STEEL SP add-on module into the global printout report (see 
chapter 6.1, page 44) for export. Then, in the printout report, click 

File → Export to RTF. 

The function is described in the RSTAB manual, 10.1.11. 

Excel / OpenOffice 
STEEL SP provides a function for the direct data export to MS Excel, OpenOffice.org Calc or the 
file format CSV. To open the corresponding dialog box, click 

File → Export Tables. 

The following export dialog box appears 

 
Figure 7.11: Dialog box Export - MS Excel 

When you have selected the relevant parameters, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, that is, the programs do not have to be 
opened first. 

 
Figure 7.12: Results in Excel 
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8. Example 
 

Column with Biaxial Bending 

In this example, the stability design of buckling and lateral buckling is carried out by analyzing the 
relevant interaction conditions according to [1]. 

Design values 

System and loads 

 

Figure 8.1: System and design loads (γ-fold) 

Internal forces according to linear static analysis  

             
   N  My Mz Qy Qz 

Figure 8.2: Internal Forces 

w 

2 m 

2 m 

V 

P 

z 

y 

IP 30 S1 

Design values of static loads: 

P = 300 kN 
w = 5.0 kN/m 
V = 7.5 kN 
 
Cross-section: IP 30 S1 
 
Material:  C 275 

4 m 
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Design location (decisive location x) 

The design is performed for all locations x (see chapter 4.5) of the member. The following 
internal forces act in the decisive location at x = 2.00 m:  

N = –300.00 kN       My = 10.00 kNm       Mz = 7.50 kNm       Qy = 3.75 kN       Qz = 0.00 kN 

Cross-section properties IP 30 S1 

 Property Symbol Value  Unit 

 Area of cross-section Ag 68.31 cm2 

 Moment of inertia Iy 10400.00 cm4 

 Moment of inertia Iz 1040.00 cm4 

 Radius of inertia ry 12.34 cm 

 Radius of inertia  rz 4.64 cm 

 Cross-section weight G  53.60 kg/m 

 Moment of torsional rigidity J 22.34 cm4 

 Warping moment of inertia Cw   287500.00 cm6 

 Elastic cross-section modulus Wyn,min  715.00 cm3 

 Elastic cross-section modulus Wnz,min 147.00 cm3 

Material properties C 275 

 Property Symbol Value  Unit 

 Characteristic strength Ryn 27.50 kN/cm2 

 Partial safety factor γm 1.025 - 

 Design strength  Ry 26.83 kN/cm2 

 Modulus of elasticity E 21000.00 kN/cm2 

Slenderness check of cross-section – Tables 9 and 10 

Compression according to 7.3 

Flange – Table 10 

Slenderness 

( ) E/Rt/b yfeff =λ  

Ry = 26.83 kN/cm2 

E = 21000 kN/cm2 

091.71.1/8.7t/b fef ==  

( ) 253.0210000/83.26091.7E/Rt/b yfeff ===λ  

Limit slenderness ratio 

λ+=λ 10.036.0uf  

E/R yλ=λ  

( )zy ,max λλ=λ  

( ) ( ) ( ) 22.8622.86,42.32max64.4/400,34.12/400maxi/l,i/lmax zz,efyy,ef ====λ  
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Ry = 26.83 kN/cm2 

E = 21000 kN/cm2 

082.3210000/83.2622.86 ==λ  

668.0082.31.036.010.036.0uf =⋅+=λ+=λ  

uff λ<λ  - Stiffeners are not necessary 

Web  – Table 9 

Slenderness 

( ) E/Rt/h ywefw =λ  

Ry = 26.83 kN/cm2 

E = 21000 kN/cm2 

12.298.0/3.23t/h wef ==  

( ) 041.1210000/83.2612.29E/Rt/h ywefw ===λ  

Limit slenderness ratio 

082.3210000/83.2622.86 ==λ  

for 0.2>λ  

λ+=λ 35.020.1uw  

60.2082.335.020.135.020.1w =⋅+=λ+=λ  

uww λ<λ  - Reduction of cross-section area is not necessary 

Cross section check  
Shear and bending according to 8.2 

Design Formula (44): 

0.13
R

87.0 2
yz

2
zzy

2
y

cy
≤τ+σ+σσ−σ

γ
 

This formula is applied to the stresses due to bending and shear that exist at the most exposed 
stress point no. 1 of the cross-section (see figure to the left). 

0.101.51.54.14.1
95.083.26

87.0 22 ≤++⋅−
⋅

 

0.192.5
95.083.26

87.0
≤⋅

⋅
 

0.120.0 ≤         - OK 

Design Formula (44): 

0.1
R cs

yz ≤
γ

τ
 

This part of the formula is applied to the shear stresses that exist at stress point no. 3. 

0.1
95.056.15

13.0
≤

⋅
 

0.101.0 ≤         - OK 
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Biaxial bending and compressive force according to 9.1.1 

Design Formula (105): 

0.1
RWc

M

RWc

M

RA

N

cymin,znz

z

cymin,yny

y
n

cyn
≤











γ
+











γ
+











γ
 

02.189.26/1.120A/A wf =⋅⋅=  

We linearly interpolate the values in Table F.1 to determine these coefficients: 

cy =1.069,  cz = 1.47,  n = 1.5 

Service factor for columns:  γc = 0.95 

0.1
95.083.2614747.1

750

95.083.26715069.1

1000

95.083.2631.68

300 5.1
≤








⋅⋅⋅
+








⋅⋅⋅
+








⋅⋅
 

( ) 0.114.005.017.0 5.1 ≤++  

0.126.0 ≤         - OK 

Stability check 

Biaxial bending and compressive force according to 9.2 

Design Formula (116): 

( ) 0.1AR/N cyeyz ≤γϕ  

Design Formula (117): 

( )43
ezeyz c4.0c6.0 +ϕ=ϕ  

For the linear interpolation of φez according to Table E.3, the values of the relative eccentricity 
mef,z and of the flexibility zλ are required. 

E/R yzz λ=λ  

082.3210000/83.2622.86z ==λ  

zz,ef mm η=  

 where zm  eccentricity ratio  
  η  coefficient of cross-section shape acc. to Table E.2 

z,czz W/Aem =  

Wc,z is the sectional modulus computed for the most compressed fiber. 

N/Me zz =  

cm5.2300/750ez ==  

16.1147/31.685.2mz =⋅=  

For 082.3z =λ , 16.1mz = and 022.1A/A wf = , the shape coefficient η according to Table E.2 
can be determined as follows: 

zzz )m6(02.0)m1.090.1( λ⋅−−⋅−=η  

485.1082.3)16.16(02.0)16.11.090.1( =⋅−−⋅−=η  

723.116.1485.1m z,ef =⋅=  
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For 723.1m z,ef = and 082.3z =λ , the value of φez can be linearly interpolated according to 

Table E.3: 

=ϕez 0.337 

The coefficient c is to be calculated according to Formulas (112), (113) or (114). 

y,cyy W/Aem =  

N/Me yy =  

300/1000ey =  

cm33.3ey =  

318.0715/31.6833.3my =⋅=  

For the eccentricity ratio 5my < , Formula (112) is to be applied to determine the coefficient c. 

( ) 0.1m1/c y ≤α+β=  

The coefficients βα and  are taken from Table 21. 

( ) 0.1318.07.01/0.1c ≤⋅+=  

818.0c =  

We can now apply the coefficient c in Formula (117): 

( )43
ezeyz c4.0c6.0 +ϕ=ϕ  

( ) 318.0818.04.0818.06.0337.0 43
eyz =+=ϕ  

Finally we get from Formula (118): 

( ) 0.1AR/N cyeyz ≤γϕ  

( ) 0.195.083.2631.68318.0/300 ≤⋅⋅⋅  

0.1542.0 ≤         - OK 
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